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Preface

The ACTIVE Governance Installation Guide covers requirements and detailed instructions
on the entire Installation Process for the ACTIVE Governance platform.

Intended Audience

This guide is intended for users who are comfortable running some system administration
operations such as making OS level configuring changes, creating users and granting various
permissions to the user and directories. In addition it may require installing operating system
patches on the machine where ACTIVE Governance will be hosted.
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Chapter 1

ACTIVE Governance Installation

Overview

ACTIVE Governance both documents and enforces business controls, enabling users to
demonstrate regulatory compliance and to promote operational efficiency. It consists of an
ACTIVE Governance Platform, which provides control documentation, approval, and
reporting capabilities, and at least one of three modules that enforce controls. ACTIVE
Access Governotr™ prevents or detects segregation-of-duties conflicts; ACTIVE Data™
Governor enforces controls on data-entry fields, forms, and business processes; and
ACTIVE Policy Governor™ implements workflows consisting of one or more SQL
statements that define actions subject to control, together with a sequence in which

statements are evaluated and the records they return are designated as “suspect tasks.”

ACTIVE Governance is a web-based application installed on a Windows server. Its
reporting capability relies upon Business Objects, a third-party software package,
components of which are also installed on the Windows Server.

Active Governance requires storage space on a relational database. In addition, Business
Objects requires storage space on a relational database for storing its Content Management
Store (CMS).
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Installation Requirements

Supported Windows Versions

Supported operating systems include the following:

Windows Server 2000 family. Required minimum operating system install plus Service
Pack 4 (SP4).

Windows Server 2003 family. Required minimum operating system install plus Service
Pack 1 (SP1).

Minimum Hardware Requirements
Active Governance Application Server should have at least
e 32bit Intel/AMD Chipsets only
e 2GB of RAM (4 GB recommended)
e Single Hyperthreaded CPU/Dual CPU (preferred) 2.5 GHz or faster

e 70 GB Hard Disk Space on mirrored SCSI disks, a minimum 8 GB should be
reserved for the STAGE directory

Active Governance Platform requirements for database

e Database: 500 MB of storage for tables for ACTIVE Governance middleware
solution. Note: This excludes the Oracle Embedded component requirements.

e 2 GB of disk space reserved for temporary data generated by SOD analytics

Minimum Software Requirements

e Databases for ACTIVE Governance should be one of the following
o Oracle 91 — Preferred*
o Oracle 8i — Supported
o My SQL 4.1.10a — Supported

e Application Server
o Apache Tomcat 5.0 (bundled with Install) - Preferred
o Apache Tomcat 5.5 - Supported
o OracleAS 10G rel 3 - Supported
o JBoss 4.0 - Supported

e BO Content Management Database

o Oracle 91 — Preferred*
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o MSDE — (If Oracle 91 database is not available)

e Web Browser

o Internet Explorer 6.0 — Preferred*

o Internet Explorer 5.5 - Supported

e Utility Software

o Database Connectivity: Oracle 91 Client Software(9.2 client)

o Unzip utility: Software to unzip “.zip” and “.tar.gz” files (E.g. winrar)

o Latest version of MDAC (available from the Microsoft download site)

e Oracle Applications Versions:

@)

@)

@)

©)

11.5.3-11.5.7 - Supported
11.5.8 — Preferred*
11.5.9 — Preferred*
11.5.10 — Preferred*

*Preferred indicates that the product is developed and certified in this platform

Installation Guide: ACTIVE Governance for Windows



Active Governance Architecture on Windows

Deployment Configuration - Oracle Database as storage

This section details the Active Governance middleware architecture using the Oracle
Database to store the Active Governance middleware repository (Oracle 8i or 9i database).

The Business Objects Content Management Store is also stored on an Oracle 91 database. If

a Oracle 91 database is not available, the Business Objects data store will be stored in a
MSDE database which can be installed using the Business Objects installer.

Architecture Diagram - AG and BO CMS DB on Oracle

Active Governence Middleware
Installation Option — Windows, Oracle

User

indows 2000/2003 Server

Web Browser Tomcat Application Server
Internet Explorer 6 ’—‘
Active Governance Website
L
BusinessObjects Portal
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Oracle ERP, App:

Oracle 9i Release 2
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Preparing to Install

This section describes the pre-installation steps that need to be carried out before installing
Active Governance

Install Pre-requisite

1.

Procure a server that meets the minimum hardware requirements as described in the
previous section. Ensure that the minimum RAM and Disk Space requirements have
been met

Ensure that appropriate OS level configurations and minimum software requirements
have been met as described in the previous section.

On the Windows Server, create a user for Logical Apps. It is recommended to create a
user ‘lapps’. This user must be the local Windows Administrator on the machine. Once
the user has been created, login as lapps to perform the rest of the installation tasks.
Navigate to Administrative Tools and choose Computer Management. User the Users programs
to create the user.

Ensure that this machine does not have Business Objects installed. Logical Apps installs
the OEM version of Business Objects XI and requires a clean machine without any prior
history of Business Objects installations.

Logical Apps software require the following ports:
6400 — Business Objects
8080 — Tomcat Web Server
8005 — Tomcat Shutdown port
8443 — SSL

Please have the SMTP Server details that are used by organization for sending emails.
ACTIVE Governance needs this to send emails.

Oracle Data Governor must be installed on all the Production Oracle E-Business
instances and the connection information must be available for every instance of Oracle
Data Governor installed. Please refer to the Installation Guide for Oracle Data
Governor for details.

Windows Server 2000 SP4 has Internet Explorer 5.0 installed by default. Please navigate
to http://download.microsoft.com and download the Internet Explorer 6 browser.

Please download the latest version of IEG.

Windows Server 2000 SP4 does not have any Unzip utility built into the Operating
system. Please download winrar from www.rarlabs.com for use during the installation
process.

Stage the LogicalApps Distribution

1. Create a staging folder called C:\LAPPS. Navigate to that folder and create a folder
called downloads.
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BN downloads =] B3

File Edit ‘iew Faworites Tools  Help |

l%Back (= - | Q)search | B Falders €% | % £ X | -

]E—ad{-tclllaé.p—ﬂ:'l,lapps'l,duwnluads j f'{) a0

Folders ®
& Local Disk (C:) N
{:I Documents and Sekkir
-3 Hp

{:I Inetpub

E_EI--lﬁI Compack Disc (D)
]ﬁ' Compack Disc (E:)

=) Removable Disk (F:)
lIl.l‘:l Mmrnm=ble Pl S0t hd
1| i B

|I:I object(s) (Disk free space; 33.8 GE) |I:I bytes |@l MMy Computer

2. Download the Business Objects installation files into this folder. Open Internet
Explorer 6, type in the provided FTP URL’s on the address bar. When prompted,
Save the files to the C:\LAPPS\downloads folder.

File Download I

@ Some files can harm your computer. |f the file information below

lookz zuszpicious, or vou do not fully trust the source, do not open or
zave thiz file,

File name: BOE=_MLBCD.zip
File wpe:  ZIP File

From: ftp. crystaldecizions. com

Wwhould pou like to open the file or zave it to your computer?

Open |

¥ Always ask before opening thiz type of file

Carnicel tare Info

3. Download the ACTIVE Governance platform installation packages to
CA\LAPPS\downloads folder. This will copy the following folders into the foldet.
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k‘l downloads [ [O] x|
Fie  Edit ‘fiew Favorites Tools  Help ‘
GBack » =+ &) | @search | Ryroiters (B| 15 T X @ | B
Address | C:appsidownloads j @G
Folders b || [ | =1 Mame | Size | Type

=1 lapps ﬂ I'E, - {#] ActovInstalation?!_far_Windows J66KE POFF
B0 ags_jnstal E B datagovemar_7_1_0_AI¢ 105,444 KB WinR,
a downloads downloads gag_reportcenter_?_l_ﬂ_b18_ga 2922KB WinR.
Cl past-install ags_?_l_U_s41_b18_ga.war 21,315KE WAR
H-1 orade | Select an item ko view its description, gags_infrastructure_?_l_U_s41_b18 137,064 KB WinR.
{:| Program Fles Ses dcor gags_schema_install_?_l_D_h18 f0,651 KB WinR
D WINNT P — (6o Enterprise X1 for Windows 1,718,933 KB F\Fpllt
{2 WTemp - gbu_setup_?_l_o_blﬁ_ga 4,342KB  WinR
iy Mekwork Places ;

-5 Compact Disc (D) i#] Install71_AppsRulessiite 937K POFF

3 My Computer i :
5} Campact Disc (E2) Kyoceramlta.accessGoverner.||c LKE LICF
(=) Remavable Disk (F:) kyoceramita.dataGoverner.Iic 1KB LICF
'El Removable Disk, (G:) kyoceramita.platform.lic 1KB LICF
"{3 Removable Disk (H:) kyoceramita.policyGwerner.Iic 1KB LICF
-G Removable Disk 1) Bora pack 710 18 KB WinR

152 Logical dpps on earth (L) W

1 | 3 1 | o]
|14 object(s) (Disk free space; 26,8 GB) |1 05 GB |@ My Computer Y

4. Navigate to C:\LLAPPS\downloads folder and Extract the ag_infrastructure_buildid.zip to
CA\LAPPS folder. The C\ILAPPS\post-install folder is created.

5. Navigate to C:\LLAPPS\downloads folder and extract the ags_schema_install_buildid.zip
to C\LAPPS folder. C:\I.APPS\ ags_install folder will be created and will contain all
the maven and the schema creation scripts.

6. Copy the C\LAPPS\ ags_<buildid>.war file to C:\LLAPPS\ ags.war.

Install Oracle Client

Oracle Client needs to be installed on the server that hosts ACTIVE Governance in order
for this application to connect to the various Oracle Databases. This includes the database
that has the AG schema (assuming it is installed on Oracle) and the database that has the
Oracle Data Governor schema. If one does not exist please install the Oracle Client. Please
refer to Oracle Client Installation Guide for further details on installation.

The post-install directory under the STAGE directory contains a file called tnsnames.ora.

Edit this file and replace the value of host, dbport and dbsid with the appropriate values for
connections to the ACTIVE Governance database and the Oracle Data Governor database.
Copy the contents of that file and append it to the tnsnames.ora in your ORACLE_HOME.

Perform this step for Windows Server 2003 SP1 ONLY

Business Objects Services do not start after installation because Windows 2003 Service Pack
1 installs a new feature called Data Execution Prevention (DEP). DEP is a set of hardware
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and software technologies that perform additional checks on memory to help prevent
malicious code from running on a system.

To add services to the DEP feature:
1. Right-click "My Computer' and click 'Properties’".
2. Under the "Advanced' tab in the 'Performances' section, click 'Settings'.

3. Under the 'Data Execution Prevention' tab click the 'Add' button.

NOTE:

4. Add the name of the services executable file (EXE). Make sure the box is check marked.
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Installing ACTIVE Governance - Oracle Database

Create Oracle Users

Ensure that the database SID information is entered in TNSNAMES.ORA file. This file is
located in C:\ORACLE_CLIENT_ HOME \network\admin folder. Two Oracle users have
to be created in the Oracle database slotted for Active Governance platform.

Invoke SQL Plus and login to the database instance as SYSTEM. Create these two user-ids
LAPPS_AG — Schema for the Active Governance Content
LAPPS_BO — Schema for the Business Objects Content Management Store

Use these SQL Plus commands to create the users:

create user LAPPS_AG identified by L APPS_AG;y
create user LAPPS_BO identified by . APPS_BO;
grant connect, resource to L APPS_AG, .APPS_BO;

Install Business Objects

1.
2.
3.

Reboot the Windows machine and login as lapps.
Create the C:\Program Files\Logical Apps\Tomcat folder.

Navigate to C:\LLAPPS\downloads folder and extract the Business Objects installer by
Invoking the BOEXI _MI.BCD1.zip, BOEXI MI.BCD2.zip and
BOEXI_MI.BCD3.zip. When prompted for an unzip location, enter the folder
CA\LAPPS_STG\BOE-XI-ML.B on the prompt text box. This self-extracting
installer will extract the install file to the C:\I.APPS _STG\BOE-XI-MI_B folder. The
Business Objects Setup.exe automatically launches after the unzip extraction is
complete. NOTE: You can manually start the installation process by running
setup.exe from the C:\[LAPPS_STG\ BOE-XI-MI.B\win32 foldet.

When you start the installation, the Microsoft Windows Installer may need to be
installed or upgraded on the local machine. If so, the Wise Installation Wizard
performs the necessary modifications and prompts you when finished. Click Yes to
restart the machine and resume the installation automatically.

In the Select Client or Server Installation dialog box, choose Perform Server
Installation.

Proceed through the Setup program’s dialog boxes and follow the instructions on
the screen until you reach the License Key dialog. Please enter the name of your
company and the License key provided along with the software.

Click Next to get to the Default Installation folder prompt screen of the installation.
The folder specified here will be used for installing the Business Objects and the
Tomcat servers. Please enter the location specified below:

C:\Program Files\1 ogical Apps\ Business Objects
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Although a different folder can be chosen, please use the convention mentioned in
this document as this location serves as a central store for the entire Logical Apps
Programs. Maintenance also becomes easier.

ii-‘%' BusinessObjects Enterprise %I Setup

Directory Selection

Please specify the direckory,

Specify the destination Folder,

Destination Folder

:\Program Files\Logicalapps!Businessobjects| Browse |

« Back | Bext = I Cancel

8. Clicking Next will display the prompt screen for storing the Common Files used by
Business Objects. Please enter the folder C:\ Program Files\1 ogical Apps\ Common
Files\ BusinessObjects\ 3.0\. These common files are also used by Business Objects
products such as Crystal Reports or OLAP Intelligence.

9. The Setup program now proceeds to the Installation Type dialog box.
10. Click New. Ensure that the Checkbox for Install MSDE is unchecked.
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iiél' BusinessObjects Enterprise XI Setup ;Iglil

Install Type

Gl
Select the desired installation type 'E

Install a new BusinessObjects Enterprise Syskem,

[T Install MSDE or use existing local SSL Server

" Expand Expand an existing BusinessObjects Enterprise Syskem,

= Custom Use this option ko choose which application Features wou want
installed and where they wil be installed. Recommended For
advanced users,

= Back I Mext = I Cancel I

11. Click Next and In the Choose Web Component Adapter Type dialog box, select the

Java Application Server and the Install Tomcat Application Server. Java SDK will also be
installed when this option is chosen.

i'&”‘ BusinessObjects Enterprise XI Setup oy ] (4

Choose Web Component Adapter Type
Install Java ar \MET Web Component Adapters

Would vou like to use:

¥ lawva application server

Use preinstalled Java application server (BEA \Weblogic, IEM
websphere, Oracle, SunCne, Tomcat, ekc.)

*manual configuration required

{+' Install Tomcat application server {IDK will be installed)

[ 15 ASP.MET {MET Framework will be installed]:

< Back | Mext = I Cancel |

12. On clicking Next, the Configure Tomcat dialog box appears. Use the default

numbers provided. Also change the Tomcat Installation directory to C:\ Program
Files\1ogical Apps\ Tomcat then click Next.
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il-‘w!;!' BusinessObjects Enterprise XI Setup

Configure Tomcat
Canfigure Tamcat and the lava SDE

Tomcak Installation Direckory:

Z:'Program Files\LogicalApps!, Tomcat),

Conneckion port I a020 Java SDE 1.4.2 Install Direckory

Shutdown park I 2005
Redirect port I add5 .
FOwSE |

< Back | hext = | Cancel |

C:\Program
Files\LogicalApps!BusinessObjects| Javashr

13. Clicking Next will display the Content Management Store (CMS) creation dialog box.
Select Oracle as the database and enter the Oracle Database Service name (as entered
in TNSNAMES.ORA). Enter the user name LAPPS_BO and password for this user.
The CMS database will be created under the schema LAPPS BO.

i'-e!:I‘ BusinessObjects Enterprise XI Setup

CMS Database Information

Flease specify the CM3 database information

— QDB Database

" S0L Server (ODBC) p— I T

Select DEr
Database I

—Database connection
Please enter the logon information For CMS database,

I Server I aspen.wis1159
DEZ
Lagin ID I laboexi
" Sybase
Passmword I bt

< Back | Mext = I Cancel

14. Click Next to continue installing the Business Objects software. After the installation
is complete, the Registration dialog box will be displayed. Enter the Registration
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number made available to you. Click on Finish to complete the Business Objects
installation.

Configuring Tomcat for JAVA Heap sizes

The Business Objects installer can install Tomcat as a Windows service. The installer does
not, however, give you the option of setting the Java runtime options, and as noted above,
the service is not started through the catalina.bat job, so the service runs with the default 64
MB heap allocation.

Perform the following steps to uninstall the Tomcat service and re-install the service with
the desired JVM parameters.

1. Replace the contents of the file C:\Program Files\LogicalApps\Tomcat\conf\tomcat-
users.xml with the following content:

<rxml version='1.0" encoding="utf-8'?>
<tomcat-users>
<role rolename="tomcat"/>
<role rolename="role1" />
<role rolename="manager" />
<user username="tomcat" password="tomcat" roles="tomcat"/>
<user username="both" password="tomcat" roles="tomcat,role1"/>

<user username="role1" password="tomcat" roles="role1" />
<user username="admin" password="admin" roles="manager" />
</tomcat-users>

This will enable you to login into the Tomcat manager as admin/admin

@% C:'.Program Files\LogicalApps'Business Objects’, Tomcathconf
File Edit ¥iew Favorites Tools Help | f,'
@ Back ~ 3 - (T | S search [ Foiders | % @ >< D | -
Address [C5 ci\Program FilesiLogicalapps\Business Objects\Tameaticonf B3| Go
Folders = || mame = Size | Tvpe [ Date rodi
& oracke ~ | [ Eocatalina File Folder 7312006
Program Files [ catalina. policy 7KE POLICY File 6172004
£ Broadeom |e=f] catalina. properties 3KB PROPERTIES Fils 6/17/2004
&b cmak [ iz . properties 1 KE PROPERTIES File 6172004
= Common Files [27] server.xml 13 KB  ®ML Document 7/31/200€
[0 ComPlus Applications [£29] server-minimal .ml 2ZKE ®ML Document 6172004
= Cutter 4 (=] 1 KB XML Dacument 8142006 1
= Intel [£29] wweb. el IIKE WML Document &/17/2004
IC=) Internet Explorer
T Java
=1 1) Logicalapps
=1 L) Business Objects
IE) BusinessObjects Enterprise 11
1L JawasSDK
IE5) MaplInfo Mapi
Iy OLAR Inteligence 11
=I5 Tomcat I
L bin
=3 bobjsetup
(£ Cataling
logs
server
shared
L kemp
[E5) webapps
I work ha Il K| | |
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2. Start — Programs — Tomcat — Tomcat Configuration: Add the Initial Memory Pool and
the Maximum memory pool configuration on the text boxes: Also add the —
XX:MaxPermSize=128m to the Java options text area.

’ # Apache Tomcat Properties |

General I Log On I Logging  Java |Startup I Shutdovan I

Java Virkual Machine:

I C:Program Filesi Javaljrel .5.0_0&%kiniclient) e, dll a0 |

Java Classpath:

I C:\Program FilesiLogicaldppsiBusiness Objecks) Tamcatibintbookskrap, jar

Java Cplions:

-Dizatalina.hame=C:Program Files\LogicaldppsiBusiness Objecks) Tarr ;I
-Djava.endorsed., dirs=C:\Program Filesi\Logicaldppst Business Objecks
-Djava.io.tmpdir=C:Program Files\Logicaldpps\Business Objects) Tomr
-naiMaxPermsize=128m -

Initial memory poal: | 256 ME
Mazimum memory pool: I 765 ME
Thread stack size: | KB

Ik I Cancel Apply

3. To verity, open Internet Explorer and type in http://<machinename>:8080. This will
display the Tomcat page. Click on Tomcat Manager Hyperlink and login as
admin/admin. Click on the Server Status on the right of the page and verify the Memory
settings in the JVM section of the page.

Installation Guide: ACTIVE Governance for Windows 15



a /manager - Microsoft Internet Explorer

Fle Edit \iew Favorites Tools  Help | "P
Qeak = - 4] 2] (0 ‘ Search - Favorites €2 | A b B
F\ddressI@http:Hdelhi:BDBDImanagerIstatus j = [
Wpache Jakarta Project
http:// jakarta.apache.org/

Server Status

List Applications HTML Manager Help Manager Help Complete Server Status

Tomcat Version JYM Version JYM Vendor 0S Name | 0S Version | 05 Architecture
Apache TomcatB 027 | 160 06-005 | Sun Microsystems Inc. | Windows 2003 2 %06

VM

Free memary: 235,33 MB Total memary: 254,06 MB Max memary: 762,12 MB

|@ http:/fiakarta.apache.org tomcat] |_ |_ |_ |_ |_ |0 Inkermet 4

4, Shutdown tomcat.

a.  Open the Services Manager by Clicking on Start — Run — services.msc
b. Click on the Service “Apache Tomcat 5.0.27” and click Stop

5. Startup tomcat.

a.  Open the Services Manager by Clicking on Start — Run — services.msc
b. Click on the Service “Apache Tomcat 5.0.27” and click Start

Deploying InfoView

1. From the C\LLAPPS\post-install folder, uncompress the desktop.tat.gz and the
adhoc.tat.gz into ¢\ Program Files\Logical Apps\ tomeat\webapps folder

2. Open the file C:\ Program Files\Logical Apps\ tomcat\ webapps\desktop\ WEB-INF\web.xm! in
a text editor
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Replace the <HOST> by the name of the server where the Business Objects was
installed. Note that if you have chosen an alternate port for 6400 during the
Business Objects Installation; change the value of the port number to reflect that

Save and exit the file

3. Open the file C:\ Program Files\1 ogical Apps\tomeat\webapps\adhoc\WEB-INF\adhoc-
config.xml in a text editor. This is for the adhoc reporting tool

Replace the <HOST> by the name of the server where the Business Objects was
installed. Note that if you have chosen an alternate port for 8080 during the
Business Objects Installation, then change the value of the port number to
reflect that

Save and exit the file.

Deploying ACTIVE Governance middleware platform

1. Copy ags.xml from C\IL.APPS\post-install to C:\Program
Files\ 1 ogical Apps \ tomeat\ conf\ Catalina\ localhost and modify the file:

This file defines data connections to the AG schema and the Oracle Data Governor
schemas

Locate the tag <ResourceParams name="jdbc/onecenterDS”>. This defines the
Active Governance Database Credentials. Within that

o If AGSis installed on Oracle
» Locate the parameter driverClassName
» Modify the value to oracle.jdbc.driver.OracleDriver
» Locate the parameter utl
» Modify the value to
<parameter>
<name>url</name>
<value>jdbc:oracle:thin:@<HOST>:<PORT>:<SID></value>
</parameter>
Locate the username and password tag underneath it and modity it accordingly

<parameter>
<name>username</name>
<value><LAPPS_AG_SCHEMA_NAME></value>
</parameter>

<parameter>
<name>password</name>
<value><LAPPS_AG_SCHEMA_PASSWORD></value>
</parameter>
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Locate the tag <ResourceParams name="jdbc/appsaccessDS”’>. This defines the
Oracle Data Governor Database credentials. Within this tag

o Since Oracle Data Governor is installed on Oracle
o Locate the parameter driverClassName
o Modify the value to oracle.jdbc.driver.OracleDriver
o Locate the parameter url
o Modify the value to

<parameter>
<name>url</name>
<value>jdbc:oracle:thin:@<HOST>:<PORT>:<SID></val
ue>

</parameter>

Locate the username and password tag underneath it and modify it accordingly

<parameter>
<name>username<,/name>
<value>apps</value>
</parameter>

<parameter>
<name>password</name>
<value><APPS_PASSWORD>< /value>
</parameter>

Save and exit the file

2. Copy ags.wat file. C\LLAPPS\ags.war to C:\Program Files\1ogical Apps\ Tomcat\webapps
folder

3. Copy the Active Governance JAR files to their appropriate directory. Copy
C\LAPPS\postinstall\ * jar files to C:\Program Files\1.ogical Apps\ Tomcat\ common\lib folder.
4. Startup Tomcat

a.  Open the Services Manager by Clicking on Start — Run — services.msc
b. Click on the Service “Apache Tomcat 5.0.27” and click Start

Configuring the Business Objects Server

1. Copy ojdbcl4.jar file from C\ILAPPS\post-install to C:\Program
Files\1ogical Apps\ Common Files\ Business Objects\ 3.0\java\ /b

2. Edit the file C:\ Program Files\1ogicalApps\ Common Files\ Business Objects\ 3.0\java\
CRConfig.xml and add the following to the front of the <Classpath> element: C:\ Program
Files\1ogical Apps\ Common Files\ Business Objects\ 3.0\java\ lib

3. Change the database records setting for the Business Objects RAS server:
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a. Log in to the Business Objects Enterprise Central Management Console, at the
following URL. If you chose an alternate for port 8080 of the installation procedure,
change the value §080 in the following URL to the correct number for your alternate
port.

i http:] | <host>:8080/ businessobjects/ enterprisel 1/ admin/ en/ admin.cwr
b. Click on Servers in the home page.
c. Click on the RAS server.
d. Set DB Records to unlimited.

4. Configure InfoView. Log in to CMC and navigate to Home-->Business Objects
Enterprise Applications-->InfoView

a. Set the Viewer to Advanced DHTML by checking the option in Viewers and setting
it to Advanced DHTML.

b. Hide the Preferences by unchecking the Show “Preferences” button under the
Display section.

c. Hide filters tab on the schedule page by unchecking Show “Filters” tab.

5. Click Start — Programs — Business Objects XI — Business Objects Enterprise — Central
Configuration Manager and Restart all the services

6. Personalize the Administrator password (Home-->Users-->Administrator).

Installation of AG Schema

Run the following commands to create AG schema objects and seeded data. This assumes
that the Oracle Client has been installed and the appropriate tnsnames have been appended
as outlined in the pre-requisites section.

1. Shutdown tomcat

c.  Open the Services Manager by Clicking on Start — Run — services.msc
d. Click on the Service “Apache Tomcat 5.0.27” and click Stop

2. Create a custom propetties file by making a copy of C:\I.APPS\ags_install\config\filters-
bundle-oracle. properties

> copy filters-bundle-oracle.properties filters-<host>.properties

3. Edit the custom properties file, filters-<host>.properties, by changing the following lines
to the appropriate parameters,

hibernate.connection.url=jdbc:oracle:thin: @<host>:<post>:<sid>
hibernate.connection.username=LAPPS AG

hibernate.connection.password=< LAPPS_AG password>

businessObjects.server=<host>
businessObjects.serverPort=6400
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businessObjects.username=Administrator

businessObjects.password=<Administrator password>
businessObjects.schema=LAPPS_AG-DC
businessObjects.appsRulesSchema=XXLAAPPS-DC
log4j.filepath=C:\Program Files\LogicalApps\tomcat\logs\ags.log
callbackhost=http://<Host>:8080/ags

4. Edit the build.properties, by changing the following lines to the appropriate parameters,
cd ..

In the build.properties file
change line 1, config=bundle to config=<host>
The <host> above must match the <host> in filters-<host>.properties filename

5. Execute the AG Installation Script to create the AG Schema and Environment. Open a
DOS command Window and change the ditectory to C:\LLAPPS\ags_install folder.
Execute the batch file everything.bat.

6. Copy the AG LOG file to its appropriate directory. Copy C:\IAPPS\ log4;.properties file
to C:\Program Files\1 ogical Apps\ Tomeart\ common\classes foldet.

7. Startup tomcat

a.  Open the Services Manager by Clicking on Start — Run — services.msc
b. Click on the Service “Apache Tomcat 5.0.27” and click Start

Installing LogicalApps Business Views and Reports

With Business View Manager installed and configured on the client system, you can use it to
do the following:

e Import XML files that support Logical Apps reports.

e Establish data connections and dynamic data connections between the client and the
Logical Apps data source.

e DPublish reports in the Business View Manager repository.

Importing XML Files (Business Views)

1. Customer Support ships the Reports in a separate zip file. Extract the contents of the zip
file into an install directory (Where the Business Objects Client install resides) You
should see a directory called Reports Center and a sub directory called Business Views.

2. Open Business View Manager.

a. In Windows, click on Programs > Business Objects XI > Business Objects
Enterprise
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b. As Business View Manager opens, log in to the server.

3. In Business View Manager, click on Tools in the menu bar and on Import in the Tools
menu and then the Import dialog opens.

E Irﬂpnrt 5'

Flease select the Business WView =ML file to import.

»ML Filename: IZ:\MyWorkspaces\Team - Engine Choose XML . |

Select the impart folder:
[l custom functions will akways go to the Custom Functions Folder.)

E & X L

= Q MEWPORT , WHG, LOGICALAPPS, COM [Administrator]
D Crnamic Cascading Prompts
-0 Report Center

¥ Preserve CUID when importing objects.
v Owenaite if CUID exists.
v terge falder security.

Chooze Repositary.. | QK. I Cancel

S

4. Ensure that the line displaying the host name and domain name for the business objects
server is selected.

5. Click on the Choose XML button, navigate to the Reports Center/Business Views direc-
tory extracted above, and select one of the XML files in that directory. The name and
path of the file should appear in the XML Filename field.

6. Ensure that the three checkboxes near the bottom of the form are selected. These are
labeled “Preserve CUID when importing objects,” “Overwrite if CUID exists,” and
“Merge folder security.”

7. Click on the OK button. Choose to overwrite if there is any existing content.

8. For the initial import, a Reports Center directory will be created in the Repository
Explorer.

9. Repeat Step 2 for all XML files located in the Report Center subdirectory.

Establishing Data Connections

As you establish data connections and dynamic data connections between the client and the
Logical Apps data source, you can set up either Oracle or JDBC. For you to use Oracle, the
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Oracle Client must be installed on your machine, and TNSNAMES in the Oracle Client
must be configured with the same aliases configured on the server side.

1. Open the Choose a Data Source dialog. In Business View Manager, click on File > New
> Data Connection.

x

Pledse choose a daka source For the Data Connection

Selected data source:

- [ Mailbox Admin =]
- [ZAMS 115/Prosy Log Files

D NT &rchived Event Log

#-[CAMT Current Event Lag

#-[Z10DEC (RDO)

=-(CJ0LE DE (#D0) J

=[] Dracle Server

] M ake Mew Connection

-3, COBRA.DEVDB

[+ CAOutloak

-7 Mtinnk AF wrbanng LI

v Show this dialog when creating a new Data Conneckion

oF: | Cancel |
A

2. If you are setting up Oracle, click on the Oracle Server entry in the list. If you are setting
up JDBC, click on the JDBC entry in the list.

If no connection yet exists, a Connection window appears. If data sources already exist,
double click on the entry for your connection (for example, COBRA.DEVDB in the
illustration) to produce the Connection window. In either case the window is specific to
the type of data-source connection you are configuring — Oracle or ODBC.
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3. Complete fields in the Connection window.

If you are using Oracle, the window looks like this:

x|
%nnection

Service: ICDBH.&.DEVDB
Uzer 1D Iacs_sc:hema
Password: Ix

05 Authentication: u

The correct entry for the Service field can be found in the tnsnames.ora file on the client
computer. Enter the User ID and Password set up by your database administrator. Leave
the OS Authentication check box cleared.

If you use JDBC, the window looks like this:
5

Connection
Pleasze enter ﬁmection information ...

JDBC Connection: (O
Connection URL: Iidbc: oracle: thin: @newport. whq logicalapps.com
Databaze Clazzname: Ioracle.idbc. driver. Oracleliiver

JHDI Connection Mame ||
[Dptional):

JNDI Connection: ‘e

JHDI Provider UBL: |

JHD zermame; Iweblogic

JH D Pazsword: I

[itrall Cantext: IJ

< Back I Peut » I Finizh | Cancel |

In the Connection URL field, the prefix jdbe:oracle:thin: is always present, and the
remainder is the URL, port number, and service name configured for your system. The
value for Database Class name is always oracle.jdbe.driver.OracleDriver.

You need to create at least 2 connections One to AG schema and at least one to
AppsRules schema

Hit Next
Specity UserlD and Password

Make sure that the xxlaaps schema has been created.
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Xxlaapps_ag / ag (AG achema)
Hit Finish
It will show the data source list connection

Hit OK

Set Data Connection Password dialog box appears. If this dialog box does not show up
then click on the password in the Property Browser (if this doesn’t appear choose it
from the menu)

Enter the schema name and password (twice)

In the drop down choose “Never Prompt”

Make sure that single sign on is unchecked

Hit OK

Click on the Save Button to save Data Connection.

Choose an appropriate name for the data connection (for eg
<HostName>_ <DatabaseName>_ <SchemaName>_ <InstanceName>

For eg: Vmware_visdb_xxlaapps_ag_ag
Save it to ReportCenter->Data Connections

Click on Save

Repeat this for the other data sources (AppsRules DataSources)

Vmware_visdb_xxlaapps_xxlaapps

If choosing Oracle Server
Service: NEWPORT.QA
Xxlaapps/xxlaapps

4. In the Repository Explorer of Business View Manager, set up dynamic data connections
(DDC).

a  Double click on AG Source Data (for connections to ACTIVE Governance source
data).

Delete all existing data connections

Click on Add

Choose the AG Source Data -> Click Add
Close

Click on Save

b Double click on AppsRules Source Data (for connections to AppsRules source data.
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Delete all existing data connections

Click on Add

Choose the AG Source Data -> Click Add
Close

Click on Save

Business Views are based on the DDC. The business views do not need to be modified
to point to the correct data source.

|Repository Explarer o x

%Ixmnw.w.

=& SUMMIT.WHQ LOGICALAPFS, COM [Administrator]
D Dynamic Cascading Prompts
=-E3 Report Center
D Access Center
-0 Appsaodit
If | AppsContral
@] AppsGRs
B Control Canter
ED Data Connections

----- {EE ACS Source Data

(35 ACS_QA-DC
{‘:ﬁ AppsRules Source Data
-5 ASPEN OracleClient-DC
LoEE LAIOLLA-DC

LofEE SUMMIT-DC

Publishing Reports

Ensure that no reports exist. Go to the desktop application and choose the Report Center
folder and Delete it. Otherwise this process with create duplicate reports

Especially if you are doing a complete dump of reports

To publish Logical Apps reports in the Business View Manager repository:

1. Log on to the Publishing Wizard: in Windows, click on Programs > Business Objects XI
> Publishing Wizard.

2. Press Next.
3. Complete fields in the Log On screen:
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Eﬁ._ Publishing Wizard

Log On ko Business0bjects Enterprise
Beforeiiuzers can access your file through the BusinessObjects Enterprise
framework, it must be added to the BuzinessObjects Enterprize spztem.

Enter the name of your BusinessObjects Enterprize system. You also need to specify
wour uzer name and password.

System;

Uszer Mame: IAdminislralor

Pazsword: I

Authentication: IEntelprise j

< Back I Mest I Cancel | Help

a. System is the host name of your Business Objects server, as well as its port number
if that number is not 6400 (the default). If you need to include the port number use
the format Nawme:nnnn.

b. Accept defaults for User Name and Password.
c. 'The value for Authentication is always Enterprise.

4. Click on the Next button. In the Select Files screen, click on the Add Folder button.
Navigate to the ./ACS71/Report Center directory. Check the Include Subfolders option.

I publishing Wizard (o x|
Sel& Files

Choose files o publish. Begin by clicking on either the "4Add Files" or the “Add
Folder" buttans.

AddFies | AddFolder FemoveFies |
Mame | In Directary -
L& AppsCaontrol Control Listing Repart.rpt 2 Zh\Mworksp:
L& AppzContral Change Histary. rpt [ ZAMyworkspe
L& AppsContral Reviewer Perfarmance Repart.rpt [ ZAMywork spe
GPS Detail Report by User.rpt [ Z MM ywork spe
GPSReportinglC17.rpt 2 2 ywiorksp:
L& &pps Access Responsibilties Menu.pt &2 2 ywiorksp:
LA &pps Access Responsibilities with Conflicts. ipt 2z W yworksp:
V-:L-} | é dmmed rreass Credlict Pole |I istimn Penrt mt ™ 7'\M||\M’nr|¢£ltll

< Back I Mest I Cahcel | Help |

5. Click on the Next button. In a Specify Location screen, ensure that the line displaying
the host name and domain name for the business objects server is selected. Click on the
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create-folder icon (the leftmost of the three above the white text area) and name the
folder Report Center.

6. Click on the Next button. In a Specify Location screen, ensure that the line displaying
the host name and domain name for the business objects server is selected. Click on the

create-folder icon (the leftmost of the three above the white text area) and name the
folder Report Center.

I'f"_. Publishing Wizard

Specify Location
Specify the lacation in which you would like your files to appear.

Select the location to which pou would like to add your filels]. ou may add a new
folder or a new object package using the buttons to the right of the folder tree.

CF g X

EI@ WEWPDRT.WHOLOGICALAPPS.COM

< Back I Mest » I Cancel | Help |

7. Click on the Next button. In a Specity Folder Hierarchy screen, select the “Duplicate the
folder hierarchy” radio button and the “<include none>" option in the list box.
e

Specify Folder Hierarchy
Specify whether or not to recreate the exizting folder hisrarchy.

'ou have chozen to add files from different folders to BusinessObjectz Enterprise. This
wizard can put all the flles in one location, or duplicate the hierarchy of the folders the
files are coming from.

" Put the files in the same location
' Duplicate the folder hierarchy

Thesze falders are common to all files. Select the toprmost folder that you would
like to include in the folder hierarchy.

¢ Back I Mest » I Cancel | Help |

8. Click the Next button an this and the next several screens; accept default values until you
reach the Specify Repository Refresh screen. In it, select Enable All, and ensure that the
“Use Object Repository when refreshing report” check box is selected.
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P Publizhing Wizard

Specify Repository Refrezh
Choose whether or not you wizh to refresh a report's repository fields. This setting is
relesant only far reparts that uze repozitony objects.

|Jser Access by Function Fepart ¥ Usze Object Bepository when refreshing
User dccess by User Report report
Enable All
Dizable Al |
¢ Back MHest > | Cancel | Help

9. Click the Next button until you reach a Choose Default Values screen. In it, select the
“Publish without modifying properties” option.

10. Click the Next button and accept defaults in any remaining screens until you can click
the Finish button.

11. Close

12. Ensure that the reports center director is created in the InfoView application
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Configure Licenses

BO Licenses

License the Crystal Reports Explorer (ad hoc reporting component) and Dashboard
Manager.

1.

Log in to the Business Objects Enterprise Control Management Console, at the
following URL. If you chose an alternate for port 8080 of the installation procedure,
change the value 8080 in the following URL to the correct number for your alternate
port.

http://<host>:8080/businessobjects/enterprisel1/admin/en/admin.cwr
Click on License Keys in the home page.

Add the Crystal Reports Explorer Add-On by entering its license code, as provided to
you by Logical Apps.

Add the Dashboard Manager Add-On by entering its license code, as provided to you by
Logical Apps.

AG Licenses

1.

ok >

Log into the Active Governance Application
http://<hostname>:8080/ags

Select the Administration Tab

Click on Manage Licenses

Type in Organization Name in the textbox.

Type or browser and select the 4 license file supplied to by Logical Apps.
a. ACTIVE Governance Platform license file = platform.lic

b. ACTIVE Access Governor license file = accessGovernor.lic

c. ACTIVE Data Governor license file = dataGovernor.lic

d. ACTIVE Policy Governor license file = policyGovernor.lic

Click on the Save button.
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Configure ACTIVE Governance Control Monitors

The ACTIVE Governance Control Monitors supplied are in the ora_pack_ <version
number>_<build number>.zip file. Please see the Policy Governor Online User Guide for
procedures for importing Control Monitors.

Configure ACTIVE Governance Application
1. Log into the Active Governance Application
http://<hostname>:8080/ags
Select the Administration Tab
Verity the version number in the lower right-hand corner.

Click on Manage Configuration Properties

ok >

Click on the key: businessObjects.server
Change PropertyValue to <BusinessObjectsHostName>
Eg (aspen.whq.logicalapps.com)
6. Click on the key: businessObjects.serverPort
Change PropertyValue to <BusinessObjectsPort>
Eg (default = 6400)
7. Click on the key: businessObjects.username
Change the property value to Administrator
8. businessObjects.schema

This should be set to the exact (Case sensitive) name provided during the time of
creating the data connection to Active Governance Schema in Step 3 of Establishing
Data Connections

9. businessObjects.appsRulesSchema

This should be set to the exact (Case sensitive) name provided during the time of
creating the data connection to the AppsRules Schema in Step 4 of Establishing
Data Connections. This connection will reflect the default AppsRules connection for
the Application. This will be the source for the Graphs and charts in the dashboard

Create AG Super User (Required for next step)

Login to the ACTIVE Governance website with user: admin and password: admin
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LogicalApps. | ACTIVE Governance

Sign In

Username

Password

Navigate to the Administration tab and click on the List Users link

Iasl 1P | Sign Out | Help
LogicalApps. | ACTIVE Governance

W System Administrator

m Control Library | Control Automation | Segregation of Duties | Access Monitoring | Reporting EEGIHTE IR IT]

Home > Administration

Control Administration
» Iport Controls fram Excel

User Administration
» ListUsers
# List Groups!
* ReporRoles Propagation

Workflow Administration

* Workflow Routing
* Waorkflow Definition

Data Administration
* Ewport
» |mport

System Administration
* Manage Data Sources
* Manage Licenses
+ Manage Configuration Properties

“ersion: 7.1.0 534 b14 REZ

Click on the Add Users button at the bottom to add a new user.

Out |Help
LogicalApps, | ACTIVE Governance

m Control Library | Control Automation | Segregation of Duties | Access Monitoring | Reporting @EGHT

Home > Administration > List Users

View Disabled

System Administrator Systemn
Administrator

459234 ag ag ag AG Super User

1028384756 sglass Seymour Auditar

Create a Super User called ag
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Tasks (58) | Profile | Sign Out | Help

LogicalApps, | ACTIVE Governance
Welcome, System Administrator

m Control Library | Control Automation | Segregation of Duties | Access Monitoring | Reporting SEGUTGEE L

Home > Administration > List Users > Add User

Login Information | User Information | Role Information \

Username *

Password *

Confirm Password * LIIIITTT)
Effective From * 08-Aug-2006 i)
Effective To =

Description -

Available Instances Selected Instances *

Lajolla.Eng

OracleApps User

SYSADMIN - []

* Required

Username: ag

Password: Welcomel (password should contain at least one uppercase and one numeric
value and should be at least 8 characters long)

Instances: select an instance
OracleApps User: select an oracle instance user

Navigate to the User Information Tab and fill out the required fields.

o Tasks (58) | Profile | Sign Out | Help
- .
i LogicalApps, | ACTIVE Governance

Welcome, System Administrator

m Control Library | Control Automation | Segregation of Duties | Access Monitoring | Reporting SRS E ]

Home > Administration > List Users > Add User

Login Information @EETEL LT FE L] Rolelnfolmmion\

ID Number *

First Name * Street 1

Last Name * W Street 2
Email 1 * [ae@iogicalapps con] City | State
Email 2 l— Province
Office Phone l— Country
Wobile Phone 1 Zip

* Required

Continue to the Role Information tab and select the AG Super User role and select all
reporting roles
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*un

Tasks (58) | Profile | Sign Out | Help
i LogicalApps, | ACTIVE Governance

‘Welcome, System Administrator

m Control Library Segregation of Dities Administration

Home > Administration > List Users > Add User

Login Information | User Information ERGENGIGIGET]

Primary Application Role * Auditor 3|

Executive
Rule Builder
50D Super User

Report Role(s) Available Report Role(s) Selected Report Role(s)

Report-Admin
Repart-Author

Report-User

Report-tanager
Report-Auditor

* Required

Click the Save button

Log out, and then log in again as the ag user you just created. Ensure that you can access all
the tabs in the application.

Run the Workflow population concurrent program

This concurrent program seeds the LA Workflow Roles table with the workflow role data.

Log in as the ag user.

Navigate to the Segregation of Duties tab and select the SOD Database Instance. Click the
Select button.

. Tasks (6) | Profile | Sign Out | Help
e .
i1l LogicalApps, | ACTIVE Governance

Welcome, ag ag

m Control Library | Control Automation I IELEIGLT RN Reporting

Home > Select Data Source

Select SOD Database Instance

Navigate to the Submit Programs link under the Segregation of Duties tab.

onn
==

Tasks (6) | Profile | Sign Out | Help|
i1 LogicalApps, | ACTIVE Governance

Welcome, ag ag|

m Control Library | Control Automation SESENEREGOHE RN Access Monitoring | Reporting

S0D Database Instance:

SOD Rules | Simulation | Global Subscribers | Mass Update | Submit Program | View Submitted Program | Entity Groups Aspen - 1159 Change

Home > Submit New Program

Program |LAAPnpu\ale W Roles Table j

No pa i with this pr ing prograrm.
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Appendix A - Change the Log Levels for Tomcat

Edit the C:\ Program Files\1.ogical Apps\ Tomcat\common\ classes\ log4j.properties file
Set the following property
log4j.logger.com.logicalapps.onecenter=INFO, file (INFO = default)
There are 4 different filter values

less logging € --------—--- - more logging
INFO > WARN > ERROR > DEBUG
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Appendix B - AG Installation Validation

After an install (including post installation steps), the following steps need to be performed:

1.

Login to ACTIVE Governance as admin/admin
Select the Administration tab and look for the release version at the bottom right of the
screen. For 7.1 release, it should read 7.1.0 s41 b18, where s41 represents the schema version
and b18 represents the build number. This information will need to be presented to support
when issues arise.
Setup licenses
a. Select Manage Licenses under the System Administration Header and enter the
license information as provided by LogicalApps.
Create Data Sources to APPS instance(s)
Select Manage Data Sources
Click the Add Data Source button
Enter the details of the data soutce and click the Se/ect button.
Click on "Test Data Source"
If "Test is Successful" message is displayed on the screen then proceed further to
step 5
Create User(s)
a. Select List Userunder the User Administration header
b. Click on _Add User button
c. Enter all required fields in the Login Information, User Information and Role
Information tabs.
Make sure to select an instance and Oracle Apps User
e. Click on the Save button to create the user

o a0 TP

6. Select Manage Configuration Properties under the System Administration header and validate all
properties including the BO properties are set appropriately.

7. Select the Reporting tab and check to make sure that you can see all report folders as shown in
the screenshot. Click on the report tab and make sure you see reports listed under each of the
tabs.
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|2 LogicalApps ACTIVE Governance - Microsoft Internet Explorer - [=5]]
T i r——" ‘ aw
QBack () » X 2] u| ) Search i Favorites @ (0w v [ @& A 3

Links €] Jira €] LAHame &]LAFanal &] Netsuits ) Product-related Instances ¥ MyYahoo! %2 Yahoo! 7 Yahao! Bookmarks "2 Yahaal bail

Address [£] http fiaspen wha logicalapps.com:B080iagsireporiCenter.do = &
['Casgie]c- [Go § 8 B ~ | ¥% Bookmarks= 49 blocked | W Check ~ % AutoLink ~ = AuicFil s Sendto> () Betings~
=

Tasks (2) | Profile | Sign Out | Help

LogicalApps, | ACTIVE Governance

‘Welcome, System Administrator

| Home | Control Library | Control Automation | Segregation of Duties | Access Monitoring g iG] Administration

Home > Reports

& | [ Mew » ¥ [ Send + My Infoview | Searchtile - = o @ |
[ Folders lapzzld]
FEEEEEES

@ 3 My Folders ’..

L]
B CaPublic Folders
& CHReport Center ... Lo Icq IA s
] ®

[ Access Monitaring

[ changeControl

(23 Control Autaration
[ Control Library

[ Oracle EBS Security
(3 OracleAudit

[ OracleFlow

[ OracleForm

Persanalize Info‘iew now
Go to Info'view Inbox

[ Seqregation of Duties
[ZReport Center Migration Test

- |

5] T T T @ intenet
4 5tan | | 2] inbox - Micrasa... | €] 1ssus Navigstar.. | L) by Dacuments || ) Business Objec.. | 3] Dacument - M., |[Z] Logieatapps . | [ @ 0] & 3 2 B >0 oL =B & 5L % s0srm

Steps to view SOD Rules screen

Login as admin/admin

Create a data source to the APPS instance as documented in step 4 above
Create a user with SOD Super User role as documented in step 5

Logout of the application

Login as the SOD Super User created in the previous step

Click on the Segregation of Duties tab

Select the instance that you have mapped for the user.

Application will be redirected to the "View SOD Rules" screen

PN DN
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Appendix C - Business Objects Integration Troubleshooting Guide

BO Configuration Validation

1.

businessobjects.username and businessobjects.username config properties must be a valid
administrator account in Business Objects. Always check access to CMC or InfoView with these
credentials before installing AGS. If this username/password won't let you access CMC or
InfoView it won't work for AGS also.

Business Objects and Tomcat must be running during the AGS installation. Otherwise the Roles
and Users won't be created in Business Objects.

If Business Objects Report Security configuration property is created and set to value "false", all
AGS users will have access to BO using the same administrator account bypassing BO security
for report access rights.

If all reports in Report Center show without hyperlinks most likely cause is that Access Rights
were not loaded from security matrix. Go to CMC and check any report if it has
FULL_ACCESS rights for some roles and NO_ACCESS to others. If no rights were set - run
loadAccessRights.bat(.sh) script again.

When you click on Reporting tab you see BO login screen. Most likely the current user wasn't
propagated to BO. Try to login to CMC with the same credentials. If it fails - go to AGS profile
page and change your password (you can change it to the same value). Your account will be

propagated.

Report Error Troubleshooting

Follow the steps below when you get “Failure to Process Prompting” message in theReporting tab
and the case when a report parameter list is not populated with its List of Values.

Login into Business View Manager.

Click on Report Center, on the right hand side.

Click on the folder where the problem occurred. (ie Segregation of Duties)

Click on the folder of the particular report we have the problem with (ie SOD User
Contflicts Summarized)

Find the prompt item that corresponds to the List of Values that is not populated in the
report (i.e. Snapshot).

In the case of Failure to Process Prompting, schedule all the prompt items.

Right click on that object and select Schedule List of Values from the menu.

Click ‘OK’ on the Schedule window that pops up.

Click on the ‘Parameters Values’ button on the next screen.

. Select the appropriate data source ‘Value’.

0. Click ‘OK,
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11. Click ‘OK.

12. Now we want to login into AGS to check our report.

13. Navigate to the reports (Reporting | Report Center | Segregation of Duties | Conflict
Summary Report)

14. Click on the report to validate that the List of Values were populated.

15. Once validated, return to the Business View Manager.

16. Navigate to the prompt item (i.e. Snapshot).

17. Right click on that object and select Edit List of Values

18. Click ‘Clear Instance’

19. You are now set up for running the reports.
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